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Agenda

 In this tutorial we will learn using the following
— The Cadence® ICFB Environment and Tools
— Creating Library, Cellview in Library Manager
— The Virtuoso Schematic Editor
— Cadence Analog Design Environment
— The Calculator Tool
— Parametric Analysis
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Cadence®ICFB

S CyawiniX X =13

Custom IC Design Tools
Front to Back Design Environment

CopiightE 1'3'3"' 2 Cadence Design System | All vights v red. l:::-:len-:-a and the
Cadence logo ar 1 :HT :I iarkis. II ﬂ' -.-|:n=r'h n:-Tﬂ'u':irr'- ective holders.

The Cadence® ICFB environment is a set of
— “Custom IC Design Tools".

It gives a complete
— “Front to Back Design Environment”
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ELIASK - X-Win32
% valmiki@ Inx-eliask:~/verilogA
FEile Edit View Terminal Go Help

[valmiki@lnx-eliask valmiki]$ cd VeriloghA
[valmiki@lnx-eliask VerilogAl$ env | grep LM
LM_LICENSE_FILE=5280@eng-cadsun.eng.unt.edu
[valmiki@lnx-eliask VerilogAl$ icfb &

[1] 15059

[valmiki@lnx-eliask VerilogAl$ []

R ictb - Log; jusrifhome/valmiki/CDS.log. . . . =19
File Tools Options Help | 1

Loading wars from .classEnv for tool asimenw e
Done with Class Initialization.
?Warning: Cannot convert string "-adobe-helwetica-medium-r-normal--0-100-75-75-p-0-i=08859-1" to type

mouse L:

ICFB Command interpreter window
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Initiating the ICFB Environment
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Launching Library Manager

Choose Library Manager
from the “Tools” menu

Conversion Tool Box...
/ Library Manager...
Library Path Editor...
Verlog Integration
VHDL Tool Box...
Synopsys Integration...
Router
Constraint Manager...
Mized Signal Environment
Analog Environment
fgzlivia
Technology File Manager...
Display Resource Manager...
CDF
AMS
Camera
ic SKILL Development... 15.log -

File Tools | Options Help | 1

loading wars from . classEnv for tool asimenw
Done with Class Initialization.
Warning: Carnot conswert string "-adobe-helvetica-medium-r-nocmal--0-100-75-T5-p-0-1i508850-1" to type

I 1

mouse L: M: E:

>
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CADENCE - Library manager

Library Manager: WorkArea: fusrifhome/valmikiMerilogA
Fle Edit WView Design Manager Help
_| Show Categores _| Show Files
— Library Cell Views
analogLib H
ahdlLih MOS_=2d Al
zhdl_debug MOS_dZ2a
analogLib TTL_a2d
basic TTL_dZa
cdsDefTechLih hcs
class hws
examples cap
functional CooS
iccd2005 coosd
pllLih CCWVS
sample cowvsd
solutions cmdmprobe
spice core
test corefragment
training delay
diode
dummy
fourier
fourierZch
grd
grnda
grudd
1lam
idc
1deal halun
iexp
ind
1opamp
iprobe
il
o
— M ges
but was defined in 1ibFile °/usrcl/home/walmiki Verilogh/cds. 1ibh’ for Lib - tests’. -
Log file is "/usrl/home valmiki/Verilogh/libManager. log". J
L= .
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Creating a New Library - 1

“  Library Manager: WorkArea: fusr]ihomefv“lklNerllogA

- 0 X

Fle Edit View Design Manager

Help

-INew

e |Ijhrary...

T e view..

T Catesary.

Load Defaults...
Save Defaults...

Cell Viewr

Open Shell Windowr

Exit

P
~x

class
examples
functional
iccd2005
plllib
sample
solutions
spice

test
training

— Messages

but was defined in libFile
Log file is "/usrl /home/valmiki/Verilogh/libManager. log".

*Aasrcl shome fvalmikiAWerilogh/cds. 1ibh® for Lib “tests”

File > New - Library

CSCE 6651: Advanced VLSI Systems

(8

UNIVERSITY,r

NORTH TEXAS



Creating a New Library - 2

« 1.Choose the directory

T X where you want to place
- Uibrary your library/tools

name |’ « 2. Name the library
e Hit OK

Directory

Models
MultiESimulation
TakMaod
eliaskDataFlots
include
simalation

T =

sl home Aralmiki /Verilogs

— Design Manager
L) Haw HOND

L) Ghaa B DA

OK | apply| cancell Help |
= =
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Creating a New Library - 3

i . o .
“  Library Manager: WorkArea: fusrl/home/valmiki/VerilogA - 0 X
8 Hle Edit View Design Manager Help |
1
_I Show Categories _| Show Fles
]
— Library Cell Views
Ticcd2oos
ghdlLihb and?2
zhdl debug inw
analogLib nias
basic nandd
cdsDefTechLib nord
class or2
examples random_nand2 bd Technology File for New Libra o
functional
iecdzO0s oK | Cancel| Help
pllLib
sample Technology File for library "tutorial”
solutions 8 N
spice If you wrill be creating mask layout or
test other physical data in this library, you
BTG will need a technolo
oy | gy file. If you plan
to use only schematic or HDL data, a
technology file is not required.
You can: . Compile a new techfile
-~ Attach to an existing techfile
4 Don’t need a techfile
— Messages
Warning: The directory: °/usrcl/homeseliask/Werilogh/ tests’ does not exist
) but was defined in libFile ‘. usrl/home/valmiki/Veriloghscds. 1ib* for Libh ‘tests’ .
] =

As and when required, associate a “techfile” with your library.

i
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Creating a New Library - 4

Librany Manager: WorkArea: /usrlfhome/valmiki/VerilogA

File Edit View Design Manager

& Show Categories | Show Files

— Library Category Cell Views
Trutorial

shdlLih
ahdl_debug
analogLihb
basic
cdsDefTechlLib
class
examples
functional
iccd2005
pllLik

sample

KMessages

but was defined in libFile °usrl/home/walmiki/Veriloga,cds.lib’ for Lib °tests’.

Warning: The directory: ‘s usrls/homeseliask/Verilogh/tests’ does not exist (E
—

| = |
The'new library can be seen in the library column of the library manager

CSE CSCE 6651: Advanced VLS| Systems r( UNIVERST LY,



Creating a Cell View

* | Library Manager: WorkArea: /fusrlfhome/valmiki/VerilogA =
File Edit Yiew Design Manager Help
INEW " [Library...
T % call Views... Ry "~ cell View
Opm f Powsd- Ondyy v Category... = \ B
Load Defaults...
Save Defaults... \/
Open Shell Window  ~p
Exit ~x
class
examples
functional
iccd2005
pllLib
sample D e e
solutions adl Create New File x
spice
test
training OK Cancel  Defaulls Help
tutorial
- tutorial

Library Mame ;

Cell Name NAND

View MName |schemat1q_

Composer- Schematic . |
Tool

- Library path file

Warning: The directory: -, usrl/home/elizsk/Verilogh/tests' ¢ _I.l"ugrljhgmefvahﬂikiweriﬁggﬂfcdg_ 1ih
) but was defined in likFile ’/’usrl/’home/’valmiki/\!eril:l ':

Choose your library, and then create a new Cell View as follows:

File 2> New - Cell View,
Cell Name = NAND2, View Name - Schematic, Tool = Composer
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Virtuoso Schematic Editor

irtuoso® Schematic Editing: tutorial NAND2 schematic
Cmd: Sel: 0

Tools Design Window Edit Add Check Sheet Options

& &

P
e

@2

DI\

M: schHiMousePoplp () E: ddsOpenLibManager ()

»

Virtuoso Schematic Editor Window

CSE CSCE 6651: Advanced VLS| Systems r( UNngTRﬁ[”gg’m



Adding an Instance of a Cell

> Add Instance |Z| |E| [zl

Hide Cancel | Defaults | Help|

Library Browse |

Cell l
View | symhol;

Hames l

frray Rows | Columns |1
Rotate Sideways | Upside Down

Click Browse to get
the Library Browser

Various shortcuts to common commands such are
available in the left toolbox:

1. placing component instances,

2. drawing wires,

3. placing ports etc.

Short pop-up help messages can be obtained by
putting the mouse on top of the icons.
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Adding an Instance - 2

Virtuoso® Schematic Editing: tutorial NAND2 schematic

Cmd: | Add Instance z
Tools Di| Hide | Cancel Defaults Help Help
B/ Library |=@naloglL ik Browse
@ cell mosd

View i
@2
N Hames
&2 g B
=Y fArray Rows |L Columns |1
_|>’? Rotate Sideways Upside Down Show Categories
o : - Library Cell
k ; | - loglih 4 :
Model name S Fmos
y/' o - o shdlLih niport ALE
Multiplier I zhdl_debuc niport auldl
7 analoglik rdport aulws
*fﬁ\l Width A || hasic nhsin cdsSpice
q cdsDefTect nbsimd hspiceD
Length B e class njfet hspices
Drain diffusion area exanples e spectre
. functional rmesd spectres
S E Source diffusion area N | iccd2005 mos symbol

pliLib rmosd

Drain diffusion periphery
Source diffusion periphery

Drain diffusion res squares

L
-

= Source diffusion res squares |

@

(M & B

o

Drain diffusion length
Source diffusion length

Temp rise from ambient

Estimated operating region

Hot-electron degradation i E: Rotate 80

E CSCE 6651: Advanced VLSI Systems r( Uﬁgg%{;{l%g};{{\g



Adding an Instance - 3

Virtuoso® Schematic Editing: tutorial NAND2 schematic

Crmed: |
Tools D

<& [

P
/%

n
‘_I\J

ISENC

L
-

O [ & A

Add Instance
Hide Cancel | Defaults

Library | =nalogLil
cell nosd
View symbal;

Array Rows l

Rotate Sideways

Model hame

Multiplier

Width

Length

Drain diffusion area

Source diffusion area

Drain diffusion periphery
Source diffusion periphery
Drain diffusion res squares
Source diffusion res squares
Drain diffusion length

Source diffusion length

Temp rise from ambient
Estimated operating region

Hot-electron degradation

Help

Browse

Coumns |1

Upside Down

Show Categories

Library Cell View
fanalogLib mosd Tsymbol
ahdlLib n2port s
ahdl debuc niport aucdl
analogLib ndport auLwvs
hasic nbsim cdsSpice
cdsDefTeck nhzimd hspicel
class njfet hspices
examples mes spectre
functional rimesd spectres
iccd2005 oS symbol
pliLib rmosd

R: Rotate 90

When the view is selected from the library
it is automatically placed in the schematic

CSE
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When the mouse is
moved on top of the
Virtuoso Schematic
window an "outline"
of the transistor can
be seen.

The outline can be
moved, rotated,
flipped this outline,
then by clicking the
left-mouse button it
can be placed in the
schematic.

Multiple ones at a
time can be put if
required number of
transistors are known
ahead of time by
specifying the
number of rows and
columns.
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0508 Schema diting; tutorial N 54 9
le:l Instance Sel: 0 z
Tools Design Window Edit Add Check Sheet Options Help

AddEL () M: schHiMousePopUpi()
L = | Point at location for the instance.

If any mistake occurs just

Edit 2 Undo and try again.

ESC key on the keyboard gets us As many instances as possible can be
out of the place instance mode added to the schematic

CSE CSCE 6651: Advanced VLSI Systems r( UNggTR;[”ES’Q\Q

M: schHiMousePopUpi) R: schHiEditInPlace ()

O mouse L: schSingleSelectPt()
= |




Connecting Components

2 Virtuoso® Schematic Editing: tutorial NAND2 schematic
Cmd: Sel: 0
Tools Design Window Edit Add Check Sheet Options

AL

% ] L)

Tt r mog' o'

'”rr pImc

mouse Lo schSingleSelectPt() M: schHiMousePopUp () E: schfoomFit{l.0 0. 9

Then add wires (narrow) to connect all the transistors as required.

CSE CSCE 6651: Advanced VLS| Systems r( UNngTRﬁ[”g;m



Adding Voltage Sources

X BES
Cmd: Instance Sel: 0 Status: Ready T=27 C Simulator: spectre 6
Tools Design Window Edit Add Check Sheet Options Help

&% [

@2
N
&2 '-‘M Add |
=3 NS nstance
Hide Cancel | Defaults
Be
Library | analogLil
15 :
cell v
T View  |symbol
M Hames IVl
B om
e B Ay Rows |1 Columns |1
_' .. Sideways Upside Down
|
i )
AC magnitude

AC phase

L
#

DC voltage
Hoise file name

Humber of noiseffreq pairs EE

[0 o B

mmmmm : mouvsehddPt () M: schHiMousePopUp ()
Point at location for the instance.

6

Adding a voltage source is same as adding any other instance.
It can be picked up from the “vdc” cell of the “analogLib”

CSE CSCE 6651: Advanced VLSI Systems r( UNggTR;[”ES’Q\Q



Final Schematic of NAND-2

-

ools

D
£

n
)

& K

mouse L: schSingleSelectPt()

ma Editing:; al NARK .
Sel: 0 10
Design Window Edit Add Check Sheet Opti Help

M: schHiMousePopUp () E: schZoomFit{l. 0 0. 93

=

Complete Schematic Diagram and Test Bench of a NAND 2
drawn using the Virtuoso Schematic Editing tool of Cadence

(&

UNIVH{bll Y;
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aunching Analog Design Environment

Virtuoso® Schematic Editing: tutorial NAND2 schematic

Cmd: Sel: 0 10
Tools | Design Window Edit Add Check Sheet Options Help
Analog Environment S S S o
Design Synthesis R L . L

Diva
Floomlan/Schematics
Hierarchy Editor
Mized Signal Oplis.
Schematics
Simulation

Status: Ready

3ession Setup Analyses Varables Outputs Simulation Resulis Tools Help

Design

Library tutorial
Cell NANDEZ

View schematic

Design Variables

#  Name Value

T=27 C Simulator: spectre 11

Analyses _%

#  Type Brguments. . ... ... Enzhble | ..
" TRAN

ane
|
rid
XYz
Outputs [E“'
o

#  Name/Signal /Expr Value Plot Sawve March

[0 B9 %

CSE

M: schHiMousePopUp () F: schEZoomFit({1.0 0.9)

{ O monse L: sch3ingleSelectPL()

In order to launch the Analog Design Environment, choose
Analog Environment from the Tools menu in the Virtuoso.

CSCE 6651: Advanced VLSI Systems r( UNggTR;[”ES’Q\Q



Sessmn

schematic Window ...
Save State ...

Load State ...

Save Script ...
Options ...

Welcome To Spectre ...

YWhat's Hew ...
Reset
Quit

setup
Design ...

simulator/Directory/Host ...

. Model Librares ...

.Temperature

' Stimuli ...

i Simulation Files .
Envlmnment

Variahles
Edit ...
Dpdais
Fand !
Copy From Cellview
Copy To Cellview

CSE

\

T=27 C Simulator: spectre

Status: Ready

ession Setup Analyses

Qutputs

Value #  Mame/Signal/ Expr ¥alue Plot Sawve March

he Analog Design Environment

Outpuis

Setup ...

fmlis

To Be Saved

T e Marchest
To Be Plotted
Save All ...
Simulation
MHetlist and Run
Run

Stop

Options

MHetlist

Output Log ...
Convergence Aids
Metlist and Debug AHDL

Bix
11

Help

g

Parametric Analysis ...
Comers ...
Monte Caro ...

L

Various important menu options in the ADE include

Session, Setup, Variables, Outputs, Simulation, Tools.

CSCE 6651: Advanced VLSI Systems
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Optimization ...

RF

Calculator ...
Results Browser ...
Waveform ...
‘ Results Display ...
«Job Monitor ...

UNIVERSITY, of
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Adding Design Variables

% Cadence® Analog Design Environment (4)

=0 X

Status: Ready

T=27 C Simulator: spectre 13

Session Setup Analyses Variables | Outputs Simulation Results Tools

Design

Library tutorial
Cell NAND2

View schematic

Help

Design Variables

Edit ...

Analyses
Davirie
Fhui cguments. ...
Copy From Cellview
Copy To Cellview

Outpuis

#  Hame Yalue

‘# Name /Signal /Expr

Value

Plot Sawe March

Variables copied
from cellview of
the schematic.

CSE

CSCE 6651: Advanced VLSI Systems

Click on “Copy from
Cellview” to include
variables from the cellview
of the schematic

L

v = Ry A 0 0 : : - 0 X
Status: Ready T-27 C Simulator: spectre 13
Session Setup Analyses Variables Outpuls Simulation Results Tools Help
Design Analyses '-E{,
# A s .. Enahl
Library tutorial | e S R | ame
Cell  NAND2 o=
117
View schematic I I I
Design Variables Outputs I:E:
#  Name Yalue |# Name /Signal /Expr Walue Plot Sawve March -
— y
1 wp = |
2 Wn
3 vID ﬁ
4  tr —
|
E  Ln

UNIVERSITY of
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ding and Editing Design Variables

Virtuoso® Schematic Editing: tutorial NAND2 schematic — Cadence® Analog Design Environment (6)
Gk Sel: 0 Status: Ready T=27 C Simulator: spectre 14

/Doubleclickon\ e
any of the |

&%«

= (1:2 Cadence® Analog Design Environment (6) e
variables to R M e
|aunCh the DeSI n (:'f ' Session Setup Analy Variables Outputs Simulation Results Tools N wde=voo
g T | Design Analyses
Varlable Wlndow ;O | pr—— #  Type T
()

. Cell HANDZ
K i view  schematic

Design Varables

Hame Falue

OK | Cancel | Apply | Apply & Run Simulation
Selected Variable Table of Design Variables | FIH

Hang Loxeq Hame Walue

VoD
tr
Cload
wtn
tox

Value {Expr) |I

“Ad | Delete | Change | Next| Clear| Fnd

epsilon
Lp

@ ks LD *

O fleSelectPt() M: schHiMousePoplp () F: sevLoadState (' sevSessionb)

The Design varlables can be added/edited by launching the
“Edit Design Variables” window in the ADE and then giving
values corresponding to the names of the variables.

CSE CSCE 6651: Advanced VLSI Systems r( UNggTR;[”ES’Q\Q



jil Adding and Editing Design Variables

OK | Cancel | Apply | Apply & Run Simulation Help

selected Variable Tahle of Design Variables
Py Voo #  Hame Walue
Value (Expr) |07 B epsilon 3.8
T witp -wth
8  toxeq epsil. .
\/7 Add | Delete | Change | Mext| Clear| Find q Lp toxeq. .
Add the 10 Ln Lp
11 wp 2+Lp
variable Cellview Variabl py | | copy Ta| |12 ¥n 4+Ln
-

When the value is
added/changed, it can be
seen in the table

Don’t forget to click “Change”
if you change a value.

Also you can Delete,
Go to the “Next” Variable, “Clear” a
value and “Find” a variable

CSE CSCE 6651: Advanced VLSI Systems r( UNI\CIE%S{IT&AS



Choosing a Simulator

Status: Ready

T=27 C Simulator: spectre

Session Setup Analyses Varables Outputs Simulation Results Tools Help

Design Analyses

Library tutorial

Cell N&NDZ
View
Des
oK | cancel |Defaults|

#  Hame

Simulator spectre
1 Wp
2 Wn Project Directory | . /sinulation |[
3 VDD
4 tr | Host Mode # local . remote . distributed T
SEET
B Lo Jssst | L

Hprnnds Dheoiay |

After the schematic design phase is over, we chose a simulator to
simulate the design. In our case we chose Spectre.

Go to Setup -> Simulator/Directory/Host, and choose

Spectre in the pop-up window, then click OK

CSE CSCE 6651: Advanced VLSI Systems r( UNI\C}EFR];IT&AS



2 spectre0: Model Library Setup

oK | Cancel |Defaults| Apply |

Adding Model Librarig

oK ‘Cancel‘ Apply ‘ 0pen|

o

Help |

#Disable |Model Likrary File

W
ot
b
=1

e

Model Library File

{rsnida
i
Dryeen

Section (opt.)

E

Fdit Dmiain

File

i

cof (Go up one directory)
Models/
MultiESimulations
TabMod/

zhdl debug/
class/
eliaskDataPlots/
examples/
1iccd2005 7
include
simulation,

Current. Directory

Chmng J it P

Browse...

Don’t Forget to “Add”
the model file before
clicking “OK”

X spectre0: Model Library Setup

oK | Cancel ‘Defaults|

Apply |

-]

— SwalmikiVeriloghs

Help ‘

#0isable |Model Library File Section

Fusclhome

salniki/Weriloga/BESIMd 45mm nominal. dat

Model Library File

Section {opt.)
I Ausrl/hone fvalniki Veriloga/BSIMA 45nm_nominal. dat

[

g Add | Delete | Change| Edit F|Ie|

I

Eandsle
Disable
Diyerty

Browse

Go to Setup - Model Libraries and choose (you can type directly or use
Browse) an appropriate library then click Add (this is important, don't

forget to do it), which adds the model for the chosen model to the
simulation environment.

CSE
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% Choosing Analyses -- Cadence® Analog Design En... E@

0K | Cancel | Defaults | Apply | Help
Analysis 4 tran g .- ac -~ hoise

. X - SENS - domatch - - sth

v v 5p woenvlp . pss

- pac - phoise . pxf - psp

o qp3s - qpac - gpnoise . - qpxf

~ Apsp

Transient Analysis

Stop Time IEEI

Accuracy Defaults (errpreset)

| conservative [l moderate | liberal

Enabled W

Options...

Choosing Type of Analysis

Choose the type of simulation, go to Analyses -> Choose...
We choose a “Transient” by clicking on the “tran” radio button.
We also assign a “Stop Time” here it's 50 which signifies 50 cycles.

Finally click OK.

CSE CSCE 6651: Advanced VLS| Systems
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Save Options for a State

24 Save Options

oK Cancel | Defaults | Apply Help
Select signals to output (save) none | selected |Ivipub | Ivl [l allpub | all
Select power signals to output {pwr) none | total |devices | subckts | all

et end of suboboed! o subed Inogtbed

Select device currents (currents) selected | nonlinear W all

Set subcircuit probe level (subckiprobelvl) |I

Select AC tenminal currents (useprobes) Yes ho
Select AHDL variables (saveahdlvars) selected | all
Save model parameters info |

Save elements info |

Save output parameters info |

Now go to Outputs -> Save All and click on allpub for signals to save
(default). In general, for large schematics, you
want to save only a subset of signals so that you save computing
resources, but this schematic is small enough that it
Is OK to just save all. Click OK.

CSE
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Loading Saved States

% Loading State -- Cadence® Analog Design Environment (1) E][E|PZ|
Ok | Cancel| Apply Delete State Help

Library tutorial

Coll HANDZ

Simulator spectre

state Name

What to Load H Analyses M Variahles B Outputs
H Model Setup H Simulation Fles B Environment Options
B Simulator Options H Convergence Setup Waveform Setup
B Graphical Stimuli Conditions Setup Results Display Setup

A saved state for a schematic contains all the
information that has been saved regarding the
schematic, including the Library, Cell Name, the
Simulator and the information to be loaded.

Just choose the state to be loaded and click “OK”

CSCE 6651: Advanced VLSI Systems r( UNI\C]E%S{IT&AS



Cadence® Analog Design Environment (1)
Status: Selecting outputs to be plotted...

Setting up Outputs

B[(=1ES

T=27 C Simulator: spectre 3

OK ‘ Cancel‘ Apply ‘

Session Setup Analyses Vanables Outputs | Simulation Results Tools Help
Design setup ... Ll ses -+
L Dpinin ki
# "To Be Saved - F e Enak L
Library tutorial | T¥P' To Be Saved nahle 2
1 Vo PR BAaroimat o aoe
Cell  NHanD2 e o yes
To Be Plotted | gpjpct On Schematic 419
. =
View schematic Save All ... G o vy 3z
Design Variables o Eflmfz;s}ve Frig I:E:
#  Hame Walue |# Name /Signal /Expr ¥alue Plot Sawe M -
1 vOD TOOm |1 wout yes all n
2 ftr 10p 2 Igawe ves
3 Cload  10f ﬁ
4 wtn 220m
k tox 1. 4n 1@[
6 epsilon 3.9

Help |

/1

Selected Output

Name (opt.) | Tg=vd

Tahle Of Qutputs
||# Name /Signal /Expr Walue Plot & Narc

Expression | average (Iqtot)

Get Expression ‘ Close |

Open

H Plotted/Evaluated

Calculator
Wil Be

1  wout

wves all no

ves
YES

| Add Delete‘ Change‘ Next‘ Hew Expressiun‘

CSE
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You can specify the
Outputs to be plotted or
saved from the Outputs
menu option.

Initially you can choose
them from the schematic

Then you can use the
Setting Outputs window
to add/edit them.
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rituoso® Schematic Editing: tutorial NAND2 schematic -- Cadence® Analog Design Environment (1)

Cmd: Sel: 1 Status: Selecting outputs to be plotted... T=27 C Simulator: spectre 2

Tools Design Window Edit Add cCheck Sheet Options Help For ChOOSIﬂg Voltage
= I e
<0 .

ey For choosing current
- click on the

>~ point/node.

2 A choice for a current
1 node is shown by a
N o elliptical ring and

choosing a voltage
changes the color of
the wire. These colors
correspond to the
color of corresponding
line plotted in the
simulation.

=

R:hiBoomBelativeScale (getCurrentiindo

mouse L: schSingleSelectPt() M: schHiMousePopUp ()

> modify_plot

CSE CSCE 6651: Advanced VLSI Systems r( UNggTR;[”ES’Q\Q
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Starting Simulation

2% Cadence® Analog Design Environment (1) E][E|E|
Status: Selecting outputs to be plotted... T=27 C Simulator: spectre 3 An al yS IS
Session Setup Analyses Varables Outputs Simulation | Results Tools Help S et u p
i HMetlist and Run
Design < UU
Run
# £
UU (Library tutorial Type 2“]‘:]
1  ftran [ Wpuons
: Cell NANDZ Netlist
DeS|gn Setup Yiew schematic Dut{:lut LD!.] ™ z Netlist
] ) Convergence Alds )
EEER Netlist and Debug AHDL [EJ and Run
#  Name Value #  Name/Signal. Debug AHDL awe March ;
UU ¥oo TO00m 3 Ignl yes j}/
2 tr 10p 4  tdHL yes
I 3 Cleoad 10f 5 tdLH yes
DeSIgn 4 wtn 220m B a yes all na
1 5 tox 1. 4dn T h yves all Du

Varlables Setup &  epsilon 3.9 2  Igpl e

™ Outputs Set

= Select on Schematic Outputs to Be Plotted

When all the setup is complete, you are ready for the Simulation.

Simulation can be started either from the menu as shown or by
clicking the “ Green Traffic Light” button from the right hand toolbox
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When the Simulation is done and
there are no errors in the Simulation.
You can see a window with the
results of the simulation as shown
here.

With an error free simulation, next
you can see the “Waveform
Window”

If you have any errors, you can
always go back to the “Virtuoso
Schematic Editor” window and
correct them

Always remember to do a “Check
and Save” when you are done with
any correction.

CSE

Simulation Results

File Help

[conmand line:

Ausrl fedsI0E033 /tools. laseBE Sspectre//binspectre —env artist5. 0.0
+escchars +log . fpsf/spectre. out +inter=mpsc %
+mpssession=spectrel_29774 1 -format psfhin -raw .. /psf %
inpuk. scs

spectre pid = 29950

Loading /usrlfcds/I05033/tools. InxB6 fspectre,1ib/cmi /3. 0/libinfineon s

Loading /usrlfcds/ICE033tools. InxB6 fspectre,1ib/cmi /3. 0/1ibnortel sh.

Loading /usrl/cds/ICS033/tools. LoxB6 fspectre/lib/cmi /3. 0/ libphilips_sk

Loading /usrl/cds/IC5033/tools. laxBe /spectre/1ib/cmi /3. 0/libstmodels_s

spectre (ver. 5.0.33.021904 —- 19 Feb Z2004).

Includes RSA BSAFE(R) Cryptographic or Security Protocol Software frow
Security, Inc.

Simulating * input. scs' on ln-eliask at 6:55:38 PM, Sun Sep 11, 2005,

Warning from spectre during initial setup.
nl: " Ckappas’ 10 m¥ iz wmsually small.

nl: "Ckappad' = 10 m¥ is urmsually small.
nl: *Ckappas' = 10 n¥ is wnmsually small.
nl: "Ckappad' = 10 m¥ is uvnwsually small.
n2: "Ckappas' = 10 n¥ is unusually small.

Further ocourrences of this warning will he suppressed.

Circuit inwentory:
nodes &
equations 24
bsimd 4
capacitor 1
quantity &
wsource 3

Warning from spectre.
L warnings suppressed.

Entering remote commeand mode using MPSC service (spectre, ipi, 0.0,
spectre0_29774 1, ).
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Waveform Window

Transient

11@n
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In case of multiple expressions generating
numerous sub-windows, you can get the
sub-window you want by choosing
Windows->Subwindows

Which launches the sub-window
management box. Just turn “ON” or “OFF”
the display for the particular window or just
“Add” or “Delete” them. Then press “OK”

W W

{ Subwindows (window: 5)

0K | Cancel Help
Choose Subwindow (s)
Title Display Update

arn

1 Expressions 1
i OOnse

Add | Delete 0On

Enahle Results Update | Disable H

Transient Response

T time (=)

R awvSubwindowdenuCE ()

mouse L:awwMouseSingleSelect M:

CSE
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Active 5

Help

o You can also switch multi axis to
®p . . . .
single axis mode in a sub-window.

aveform Window -- Cadence® Analog Design Environment (1) @
Active 35

Window Zoom Axes Curves Markers Annotation Edit Tools Help

J y

mo L:awviousesingleSelectPECE () M:
=

Tool box icon for
SW i tC h i n g AX eS mouse L:awvMouseSingleSelectPtCE() M: F: awviSwitchisisModeCE ()

>
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2a Waveform Window --

g Memories

Transient Response

Constants Options

Window Zoom Axes Curves Markers Annotation Edit Tools

Cadence® Analog Design Environment (1)

Evaluate Buffer

browser vt

wave vT

family Vs

erplot vidc
plot op

printvs ¥h

prnt mp

Display Stack

idc
opt

var

lastx | X<=y | dwn

clear

enter

= | = | =

cist
undo
[i]
]
2

up
app

eex

+-

& standard

sto

sin

COs

sinh

cosh

rcl
asin
acos
atan
asinh
acosh

atanh

RF

Special Functions

mag

phase| log10| 10""%
real | dB10| y™"=

imag | dB20| x**2

fl

In

2

exp

13

int

1%
sqrt

T4

CSE
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The Calculator

The calculator is an extremely
efficient tool that can be used
to perform various operations.

You can launch the calculator
by clicking on the calculator
icon on the tool box on the left
of the “Waveform Window”

It can be used to draw and plot
the desired waveforms and
evaluate and set up variables
and expressions.

An efficient use of the
calculator can make a lot of
difference to the way you
design and analyze the circuits.

UNIVH{bl TY,r
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Using the calculator we can
save the data from a
waveform and use it later.

Window Memories Constants Options

wavewhslil (]II

Evaluate Buffer . S a - : . )
orowser || vi| - . 1. Click on “wave” in
wave vl ; : : “ Ca|CU|a'[Or"

family

2. Click on the desired wave
on the “Waveform Window”

erplot vid
plot off = *

Hntvs v

“wave”

3. Click on “printvs”

4. In the “Printvs Range”
window give the range.

5. Click OK

“printvs”

mouse L:awviousesSinglesSel M: R:awvileleteMeniCE |

Chose the waveform _
6. You will get the “Results

2% Printvs Range Dis P I ay” window
OK Cancel | Defaults| Apply Help
From |500m To |1.0 linear By |
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Saving Waveform Data

Window Expressions Info Help 7
¥OD average ( ({({abs({({{{getData("pl:igh" ?result "tran") + g
S00m 29. 71n
510 Bm A2 07n
G20 dm 34 58n
530 bm AT, 23n
540, 8m 40, 05n
581m 43 03n
561, Em 46, 190
571 dm 49 E3n
581 . 6m 53.07n
591 8Bm 56, 81n
60%m g0, Tin
612, 2m g4, 95n
BEE. dm 69, 36n
B3E Tm T4 03n
B2, Om T2, 95n
653 1m g4, 1dn
B63. 3m
673, Em
ggg ;ﬂ OK | Cancel Defaults| Apply Help |
Hitsmns | Faemras e oe— o=
714 3m Print from window 7 . | Humber of Characters Per line ISE‘
e Print To
T34, Tm I
744 O - Printer  Cosswpmd illi'f -F
755 1m 4 Fle File Mame | V&ND2 Plot. raw
T65. 3m
775 Em Tie. on
T8E Tm 183n
795 Om 193, 6n
206, 1m 204 8n
] P— -

CSE

After giving the range in the
“Printvs Range” window, you
click “OK” you get the
adjoining “Results Display
Window”

The data from this window can
be either printed directly to a
printer or it can be printed to a
file.

Choose,

Print To - File option and give
the file name.

Your simulation data is now
saved!
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2% Cadence® Analog Design Environment (1)

Status: Ready T=27 C Simulator: spectre
Session Selup Analyses Vanables Outputs Simulation Results Tools He:
) Parametric Analysis ...
Design Analyses

Comers ..

3
Ip

# A 15
Library tutorial e P Monte c""l:|
Tan - in Optimizationm ...

Cell NANDE RE
View  schematic Calculator

) ) Resulis Bi

Design Varables Outputs
Waveform|

#  Nane Value #  Wame/Signal/Expr ¥alue  E Results D
1 VD 700m 1 wout Job Moni
2 kr 10p 2 Igpl waves  yes
3 GCload 1of 3 Ignl waves  Yes
4  wtn 220m 4 tdHL 2E6. 8p
5 tox 1.4n 5  tdlH 85.48p
& epsilon 3.9 6 & ves &

» Results in .../homefvalmikiNVerlogarsimulation/MAHDZ fspectrefschematic

BE]

2 Parametric Analysis - spectre(0): tutorial NANDZ schematic

X

Tool Sweep Setup Analysis Help | 9
Sweep 1 Variable Name | 20% Add Specification
Range Type From/To From 1.4x To |20

sop ool 0| Tt s

CSE
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Using Parametric Analysis

Parametric Analysis allows you to
run automatic simulations for over
a range of values of a specified
parameter.

You can launch the parametric
analysis tool from the Cadence®
Analog Design Environment Tools
menu.

Choose:
Tools = Parametric Analysis

Specify the “Variable Name” on
which you want to run the
analysis. Specify it’'s range and
Total Steps and click “OK”

(&
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Setting up Parameter

rametric Analysis - spectre(0): tutorial MAND2 schematic

Tool Sweep Setup | Analysis

Pick Name For Variable B N
=TT Auld Hew Variable To Top
Sweep 1 Add Hew Variable To Bottom \e | £0%
Delete Variahle ...
Delete Range Specification ... 1. 45
Range Type Delete All Range Specifications |
S - Lhadn inal (s |1EI
p ton Select All Range Specifications epsilon
frapdnol A2 Sowe Sneaifioniiong :tp
oMeq
Lp
Ln
In order to run Parametric Analysis chose the g
. Wn
variables from
Setup - Pick Name For Variables - Sweepl

And click “OK”
This will fill the variable field.

You can choose multiple parameters for multiple
sweeps.
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Tool Sweep Setup Analysis Help | 39
Start File Help | 10

““““““““““ Hiart . Hsleoled

———————————————— start of parametric run Sep 12 13:

Sweep 1 Stop ale Hame | 597 Add Specification generate netlist. ..

Fapigs . .successful.

Pagran Haw q - 0TI sinulator input file. ..
Range Type g Contin Lan To 2.t .successful,

 Show Sweep Sets i ulator ;flneeded. .
Step Control rovr Steps csuccessiul,

ENN
tion completed successfully.
0 parametric simulations remainineg.
Setting tox = 1.466GEEEEEEREEETE-0D
compose simulator input £ile.
... successful.
start simulator if needed. .
...successful.
simulate.
simulation completed successfully.
8 parametric simulations remainineg.
Setting tox = 1.533333333333333:-08

Waveform Window 2 -- Cadence® Analog Design Environment (1)

Window Foom Axes Curves Markers Annotation Edit Tools

X

*}I{“ lator input file. .
cessful.
tor if needed. ..
cessful.

simulate.

J .0

By
=

Run Parametric Analysis by
choosing Analysis - Start.

LLLL )
LLLL ]
R | LT
i

[

This gives the Analysis status
and the final result waveform.

mouse L:awviouseSingleSelec M: F: awvileleteMenuCE ()

>
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Summary

* In this presentation we learnt how to use the
various components of the ICFB design
environment of Cadence®

 We also discussed in detail the features of
— The Virtuoso® Schematic Editor
— The Calulator toal,
— The Waveform Window and
— The Parametric Analysis tool.
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